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✦ December 26 - January 7…January Competition 
Simplicity – OPEN 

✦ January 6…8:30am - 11:30am  
 Field Trip: Memory Grove Snow Shoot 

✦ January 11…6:30pm - 8:00pm (Zoom) 
Shutter Up Social: Mountains, Rocks, & Rivers 

✦ January 17…6:30pm - 8:00pm (SLC Library) 
Action Photography 

✦ January 20…3:00pm - 6:00pm 
 Field Trip: Utah Lake Ice Formations 

✦ January 25…6:30pm - 8:00pm (SLC Library) 
 Competition Meeting 

✦ Coming in February…. 
 Advanced Birds in Flight Photography 

✦ Upcoming Exhibits…April - June / September  
 (Submission deadlines to be announced) 
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Current/Upcoming Events

2023/2024 
Competition Themes

September…Long Exposure – COMPLETE 
1/2 second or more 
 
November…Macro Life – COMPLETE 
Get close 
 
January…Simplicity 
Capture your subject in its simplest form 
 
March…Street Photography 
Record everyday life in a public place 
 
May…Glass in Any Form 
Windows, glasses or any other glass 

The Wasatch Camera Club Board would like to 
wish you and your family a Happy & Healthy 
New Year!  
 
The camera club is an all-volunteer organization 
operating as a 501(c)(3) non-profit organization. 
Membership fees and donations the club 
receives throughout the year are used to fund 
maintenance of the website, competition 
judges, outside presenters and other 
professionals contracted for workshops and 
other club programs.  
  

Your camera club Thanks You!  

Donate Here

https://wasatchcameraclub.com/activities/competition
https://wasatchcameraclub.com/news-and-events/events/memory-grove-snow-shoot
https://wasatchcameraclub.com/news-and-events/events/mountains-rocks-and-rivers-shutter-up-social
https://wasatchcameraclub.com/news-and-events/events/action-photography
https://wasatchcameraclub.com/news-and-events/events/utah-lake-ice-formations-3
https://wasatchcameraclub.com/activities/competition
https://wasatchcameraclub.com/donate
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About the Cover Image

The Big Bang by Randy Gerdes
While I love my new home state of Utah, I am also partial to 
the Sonoran Desert in Arizona, where I spent a big portion of 
my adult life. I don’t consider myself a plant/flower 
photographer, but for several years I was a member of the 
Desert Botanical Garden. My membership allowed me to 
enter the garden an hour before the general population 
(when it’s peaceful, quiet, animals are out, and the light is at 
its best), helped me improve my overall skills and discover the 

“secret lives” of desert plants. While it’s often assumed that the desert is a dry, stark environment, it’s 
actually one of the most diverse climate zones, both in its animal population and its plant population. 
It’s not uncommon to encounter a number of photographers there, some with 600mm lenses shooting 
the many hummingbirds, road runners, woodpeckers, owls, cactus wren, goldfinches, rabbits, rock 
squirrels, varieties of lizards, and the occasional snake or tarantula that call the garden home. 
  
When I made this image (2017), my gear was Canon and I would walk the garden for hours on the 
weekends, usually carrying only my favorite lens, an EF 100-400 f/4.5-5.6L IS II USM. Although quite 
heavy, it’s fast enough to handhold in many situations, and considered a great macro lens for its 
extraordinary bokeh when shooting wide open. Due to the weight of the lens and my full-frame camera 
body, I avoided a camera strap around my neck, preferring instead to use a hand strap on the camera 
body (which explains why my right arm is longer than the left.) Though I’ve moved on from Canon, that 
lens is the item I miss the most.  
  
“The Big Bang” was taken, handheld, with that lens in late February. Although blooming things really 
explode in April, there are usually wonderful flowers blooming somewhere in the garden in almost any 
month, though some may only bloom for one night a year. On that day, I shot 105 frames, but only five 
of the pink fairy duster (Calliandra Eriophylla), and only one I considered having some potential. 
  
I’ve learned more about Lightroom since this photo was taken, so I am fortunate that this one did not 
require much editing except to add a bit of clarity, contrast, and a crop. It’s not often easy to name 
your photos creatively, but this one just jumped out at me. I think the image name is important and 
worth spending some time on. 
  
I recently posted this image to the Facebook page of a magazine I subscribe to (FRAMES) and 
received nice feedback from a fellow subscriber: “This is an instance of what would be a fine, but 
maybe not astonishing image that gets completely leveled up by the simply. perfect. title. All of a 
sudden motion, dynamism and energy that might not have read in the image alone are completely 
foregrounded in the mind of the viewer. Well done, indeed.” 

The Big Bang: Canon 6D, f/4.5-5.6L 100-400mm II lens at 400mm, 1/200 sec., f/5.6, ISO 100 

Photo Credit: Joe McNally
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Member Profile – Danice Cole
Born in Roseburg, Oregon, but living in the Salt Lake Valley most of 
her life, Danice found herself behind the lens longer than she can 
remember. However, it wasn't until 2010, when she acquired her first 
DSLR camera, that her passion for photography truly blossomed. This 
marked the beginning of a journey that would take her across the 
globe, exploring remote corners and seeking out the hidden gems of 
the natural world. 

Danice's educational journey led to the University of Utah, where she 
earned her BS in Business Management in 1999 and, in 2007, an MBA. 
Her career unfolded in the field of finance, working as an accountant, 
tax instructor, tax preparer for individuals and, until her retirement, as a 

Corporate Tax Accountant from Dyno Nobel Inc. Throughout her professional life, Danice's artistic spirit 
found an outlet in photography, making its way into marketing materials and calendars distributed across 
the mining industry in North and South America, as well as Australia, and hanging in the corporate offices 
of Tradestar and Dyno Nobel.  

Described as having a natural eye, Danice’s photographic craftsmanship evolved through various mentors, 
camera clubs and groups. Joining the Wasatch Camera Club in 2016, she took on the role of Field Trip 
Director. Although her tenure was relatively short due to family and work commitments, she loved doing it. 
Considering herself primarily a landscape photographer, Danice's love for photography encompasses 
wildlife, night photography, and the documentation of aged structures, including buildings, ghost towns, 
and barns. 

Danice prefers to avoid the landscape clichés and seeks the unexplored. She expresses a fascination with 
the forgotten treasures of the natural world, drawing inspiration from the allure of Grand Staircase 
Escalante, Bryce Canyon, and the remoter corners of Utah. She really loves foreign travel, with experiences 
in Nepal, Morocco, Paris, Italy, Germany, and Switzerland. These journeys are highlighted by immersive 
cultural experiences, such as joining a rice harvest with locals in Nepal. 

Beyond photography, Danice is an avid skier, outdoor enthusiast, and a practitioner of various crafts. Her 
employer commends her adventurous spirit, noting her ability to capture the emotions evoked by slot 
canyons, arches, and wild horses. This sentiment is echoed in the praise she receives for her work. 

To Danice, photography is not about competitions or a means for profit. It's an expression of joy and a 
profound connection with nature. “It’s like a thirst I cannot quench, I cannot get enough.” Whether it’s 
feeling the cool breeze in a slot canyon, hearing the thundering hooves of wild horses, a bird’s wing-beats 
overhead, or walking where the ancients once did in Monument Valley, Danice's lens is not just a tool; it's a 
conduit through which she experiences and shares the intricate beauty of the world around her. 

– Greg Smith, Board Director & PSA Chair
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Making the Case for Entering Competitions

By Lisa Thompson, Board Director & Workshops/Presentations 
Judging during a competition is subjective. As a judge, I can view your image only through my eyes, based on 
my life experiences and years of shooting and editing while striving to perfect my craft. Certain images will 
resonate more with me than other judges or viewers. The image with the highest score or the most votes wins. 
If you did not score as well as you expected or hoped, don’t give up. If you didn’t place, it doesn’t mean that 
your image lost or failed in some way and it doesn't mean that all your work is “bad.” As a judge and as a 
viewer, I look for: 

✦ An emotional or physical reaction. Did I wince? Take in a breath? 
Or pass it over without much thought? I occasionally have a 
physical reaction to an image – sometimes negative and 
sometimes positive (and occasionally both). I try to identify what 
about the image caused my reaction.  

✦ Is there a story in the image? As a judge or a viewer, can I express 
the story?  

✦ Is it technically correct? Is the horizon straight, does it follow the 
rule of thirds, have no distracting bright spots, and is the editing 
clean (minimal noise, no sensor dirt, and in focus where it should 
be?) Is it properly exposed? Is there anything that is over or under 
done in a way that will take away from the image? Is it cropped too tightly or loosely? Is it balanced?  

✦ Pay attention to where your eye goes first; is that your intent? Is there a clear subject? Are the lines in the 
image leading the viewer back into the image or out? Are there distracting areas that draw the eye away 
from the intended subject?  

Entering a competition and being open to critique will require you to lean in and you will learn if you do. I 
encourage you to listen to what is offered by the judges, and see if it applies to your artistic intent. There is a 
chance you won’t agree, but there is a better chance that you will see anew through the eyes of another. How 
to handle a critique:  

✦ Carefully consider what the judge has offered and take from it what makes the most sense to you. There is 
something to be learned from a critique every single time.  

✦ Be open and watch yourself for a defensive reaction. Being defensive can get in the way of learning from 
the critique.  

✦ Don’t awfulize. If one image did not score well, it doesn’t mean that every image you have is a dud, or that 
you shouldn’t enter competitions or share your work. Deciding what to enter is an excellent exercise and will 
increase your photographic skills exponentially. Some considerations when choosing images are:  

✦ Will your image evoke a feeling that is common to most people? Universal feelings include awe, surprise, 
beauty, empathy, revulsion, or happiness. 

Continued on next page…
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Making the Case for Entering Competitions (cont.)

✦ While viewing our own images, it reminds us of the experience of making that photo; the weather, the 
planning, who was with us, what happened on the outing, how comfortable we were or our mood. The 
viewer won’t have access to those memories, and their interpretation can be entirely different from your 
intent. Pictures of your kids, pets, or family vacations may make your heart sing, but may not resonate with 
others without a backstory. 

✦ Consider your audience and the theme. Any one image may not be suitable for every competition.  

✦ Titles are important. Take time to choose a title that furthers your story and adds to the creativity of the shot.  

✦ Ask yourself if the viewer can tell the intended story without you there to narrate.  

There are ways to become more skilled in competitions and photography overall. Set goals to improve. 
Participate in exhibits. Keep entering competitions. View others work, including the Masters. Do you like it or 
not? Why? How does it make you feel? View many forms of art, including paintings, sculptures, fiber art, 
architecture, good and bad design and Mother Nature. Entering a themed competition, especially one that 
centers on a topic that you don’t usually shoot, can push you out of your comfort zone and challenge you.  

Judges offer a valuable opinion based on their own experiences. You can learn from every judge and every 
competition. Even if the judge has no experience with the subject, it does not disqualify them from being a 
judge. Sometimes, a judge or a viewer won’t see the meaning in an image. Is it your image or their 
interpretation of your image? Could your meaning have been clearer? If a judge that is a portrait photographer 
can appreciate a picture of a dragonfly, then you have done your job. Those photographers that shoot the same 
subject may have a greater appreciation for the techniques or difficulty of getting a specific shot. The only thing 
that matters during a competition is the presentation of the final image.  

Judges are not the final authority on what is good or bad and some judges are more effective than others. One 
may be better at critiques or take more thoughtful time to view images, while others have better people skills or 
are better at recognizing technical aspects. This does not make their advice any less valuable. They are a slice of 
the overall viewing audience and they represent others that may view your work in the same way.  

Our images are very personal, and it isn’t easy to share images and open up for critique. Over time, our 
perceptions, opinions, and emotions will change. How we feel can be different from day to day; even minute to 
minute. What we love today, we may not love tomorrow. How I view my own work can vary widely. Sometimes I 
am my own worst critic and at other times, I think I have an impressive body of work. How I view my own work is 
influenced by my mood, by music, the experience I had while shooting the image, and my expectations. If you 
feel like your images are not “good” enough, walk away for a bit. Be kind to yourself.  

One other thing; don’t wait until the last minute to pick your competition images. As you are editing, if you see 
an image that may make a good competition candidate, mark it so you can find it again. Put it in a collection in 
Lightroom, keyword it or put it in a separate folder. Waiting until the last minute to comb through your library 
looking for the “right” image can be time consuming and stressful.  

Taking advantage of WCC and PSA competitions and other competitions outside of the Club will make you a 
more thoughtful, skilled, and creative photographer. Your images are meant to be seen and not buried on a  
hard drive. What we learn from photography can be applied to the rest of our lives. I challenge you to prove  
me wrong! 
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Competition Recap

November Results – Macro

CLICK HERE to view all Competition Submissions

Award Title Member

1 Time is Clicking Hiroshi Kamaya

2 Free Flowing II Andrea Dahl

3 Bee Dawn Griffith

HM Cat Faced Spider Dawn Griffith

Time is Clicking  by Hiroshi Kamaya

Intermediate – First Place

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-FHJSHJV/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-Vx2svMp/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-SJhKPCT/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-rrzppN6/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
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November Results – Macro (cont.)

The Big Bang by Randy Gerdes 
Best of Show

Award Title Member

1 The Big Bang (Best of Show) Randy Gerdes

2 Gladiator Tree Frog Cindy Costa

3 Red-eye Tree Frog Cindy Costa

HM Clematis Seed Head Elizabeth Roach

Advanced – First Place

CLICK HERE to view all Competition Submissions

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-qnG6Jfg/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-dbDV4ZP/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-MBznDNB/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-8bJsztF/A
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November Results – Macro (cont.)

Masters – First Place

26 by Jason Cameron

Award Title Member

1 26 Jason Cameron

2 Take a Bow! Stephen Clayson

3 Show Off Veloy Cook

HM Follow the Yellow Brick “Rose” Stephen Clayson

CLICK HERE to view all Competition Submissions

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-6XCWx69/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-SpT4WVT/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-b6BrjNk/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-zKnVSvf/A
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November Results – Open

Intermediate – First Place

Award Title Member

1* Still Art Tammy Stoner

1* Upside Down? Tammy Stoner

3 Seedlings Andrea Dahl

HM I love the warm breeze air in Hawaii Hiroshi Kamaya

Upside Down? by Tammy Stoner

* Two-way tie

Still Art by Tammy Stoner

CLICK HERE to view all Competition Submissions

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-RXpC9zt/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-hGdckFW/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-T8ZFPhN/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-3jFQ8zh/A
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November Results – Open (cont.)

Advanced – First Place

Award Title Member

1 Spotted Dolphin Cindy Costa

2 Thunderbird Sunrise Wendy Ovard

3* Lucky Shot Cindy Costa

3* Castle in the Clouds Paul Baird

* Two-way tie

Spotted Dolphin by Cindy Costa

CLICK HERE to view all Competition Submissions

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-WGvvdwb/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-v2k2VHM/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-HMBmtVG/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-VWhjcBv/A
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November Results – Open (cont.)

Masters – First Place

First Light on the Butte by Stephen Clayson

Award Title Member

1 First Light on the Butte Stephen Clayson

2 In the Quiet Moments Veloy Cook

3 Staying Power Keith Hill

HM Silver Road Jason Cameron

CLICK HERE to view all Competition Submissions

https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-nVVGh27/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-5XSgDFt/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-PX8FkQq/A
https://wasatchcameraclub.smugmug.com/Competitions/2023-2024-Competitions/November-2023-Competition/i-3swvn5z/A
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The Quest for a Sharper Image 

By Lisa Thompson, Board Director & Workshops/Presentations Chair

Part One of a Three Part Series

Many modern telephoto lenses and cameras have built in image 
stabilization. Image stabilization is a boon to photographers as it 
often leads to a sharper image. Low light, heavy lenses or shaky 
hands can lead to frustratingly blurry photos.  

Let’s consider the magic that is image stabilization. There are two 
types of image stabilization. One is in camera (in body image 
stabilization or IBIS) and the other is in lens. Very simply, IBIS is 
done by software built in to your camera. As the camera detects 
movement, the sensor shifts to compensate. In a telephoto lens, 

image stabilization software in the lens shifts the optical elements to compensate for movement. 
Some camera systems have both in body and in lens stabilization that work together. All of this 
shifting happens very quickly (magic!)  

When is the right time to use image stabilization? Generally it is appropriate to use it while hand 
holding, especially at slower shutter speeds. If you have your camera mounted on a tripod or other 
stable surface, it is best to turn image stabilization off as it can introduce movement and lead to 
blurry shots.  

Often image stabilized lenses have mode switches that apply to different shooting situations. 
Generally, mode 1 is for hand held shooting and the first choice for most shooting scenarios. Mode 
2 is for panning, which turns off stabilization horizontally. This will keep the image stabilization from 
interfering with intentional sideways camera movement. Some will have a Mode 3, which may be 
more appropriate for video or subjects that are erratic like birds in flight. As with ALL things you 
read on the Internet, it is important to verify what your lens buttons will do. The next step is to 
experiment and pay attention to which mode serves you the best.  

Make it part of your pre-shooting checklist to verify image stabilization settings. I program a button 
on my camera so I can quickly turn off in camera image stabilization when needed. Lens stabilization 
is usually turned off by a switch on the lens. Be sure you understand how it works and how to turn it 
on and off.  

Even with a camera’s ability to shoot at high ISO (to allow a fast enough shutter speed for hand 
holding,) doesn’t mean you should. High ISO images are often lower quality because of noise. A 
tripod used correctly (with no image stabilization) can lead to the sharpest image. Tripods are not 
practical in many situations, so the use of image stabilization may give you the most options. We 
have advanced magical tools built into our lenses and cameras that increase our chances of being a 
successful photographer. Make sure you learn these tools and then use them to increase the 
number of keeper shots you take! 
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PSA News

Questions: psa@wasatchcameraclub.com

Image Analysis Workshop Recap 
Twenty-five members, including 6 participants, attended  
this workshop, run by the PSA as a benefit of our club 
membership. Moderated by Heide Stover, APSA, QPSA,  
the participants were coached through a series of exercises  
after viewing an instructional video. We all learned the 
importance of: using the personal voice (“To me, this image 
shows…”); defining and expressing the artistic elements of 
color, light, creativity, composition, presentation, technical, 
impact, and story when judging an image; identifying distractions and split interest, how eye movement across 
a photo depends on the viewer’s context; and recognizing and minimizing our personal biases. The workshop 
culminated with each participant evaluating a photograph provided by one of their peers, followed by a 
rebuttal or explanation by the image maker. This made for some interesting discussions, such as the significance 
of the “phantom foot” in John Nellist’s image of a busy Tokyo intersection. Although not recorded, Heide 
provided a written summary of this workshop’s important points, which may be accessed here.   

Interclub Competition 
  
PID-Color: Twelve images from 9 makers were submitted, from which the best 6 from 6 different members were 
entered. Judged by The Evolve Group from England, our scores varied from 8 to 12 (out of 15), placing us tied 
for 15th out of 21 clubs competing in our group. Congratulations go to Jim Roach, who’s image July 4th 
earned him an Honorable Mention from the PSA! 
  
PID-Monochrome: Eleven images from 8 members were submitted. Our 6 entry scores ranged from 6 to 13, 
placing us tied for 15th out of 30 clubs. Jake Stockman’s Bridge Arch earned an Award of Merit with a score 
of 13 out of 15. Great work Jacob! 
  
Nature: This continues to be our strongest division. Nine images from 8 members were received, 6 were 
selected for entry but, in error, only 5 were sent to PSA. Fortunately, we will be able to submit the sixth entry as 
a makeup during the Round 2 competition in February. I am pleased to announce that three of our 5 entries 
received awards! Merit awards went to Paul Harrison for Alaskan Bear with Salmon and to Stephen Clayson 
for Hungry Mouths to Feed. Cindy Costa was awarded an Honorable Mention for her Mountain Bluebird 
image. Scores were from 10 to 14 (Paul’s), putting us in 9th Place out of 34 competing clubs (and that’s with just 
5 entries.) Great work everyone! 
  
Scores, club standings, and links to our entries and all PSA winners may be found on our website’s PSA 
Interclub Competition page. Other PSA news can be found on the WCC website here. 

By Greg Smith, Board Director & PSA Chair

Continued on next page…

Photo Credit: PSA Image Analysis Workshop

https://wasatchcameraclub.com/news-and-events/resources/item/144-image-analysis-recap
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/PID-Color/Round-1/i-M8Z3xVT/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/PID-Monochrome/Round-1/i-v2txhsJ/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-NKxbDgW/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-HjMqnWr/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-j8wmFRq/A
https://wasatchcameraclub.com/activities/psa/item/137-psa-interclub-competitions
https://wasatchcameraclub.com/activities/psa/item/131-upcoming-psa-events
mailto:psa@wasatchcameraclub.com?subject=PSA%20Question
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Questions: psa@wasatchcameraclub.com

PSA News – Interclub Competition (cont.)

July 4th by Jim Roach 

Honorable Mention / PID Color

Bridge Arch by Jake Stockman 

Award of Merit / PID Monochrome

Alaskan Bear with Salmon by Paul Harrison 

Award of Merit / Nature

Hungry Mouths to Feed by Stephen Clayson 

Award of Merit / Nature

Mountain Bluebird  by Cindy Costa 

Honorable Mention / Nature

mailto:psa@wasatchcameraclub.com?subject=PSA%20Question
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-j8wmFRq/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-NKxbDgW/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/PID-Color/Round-1/i-M8Z3xVT/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/PID-Monochrome/Round-1/i-v2txhsJ/A
https://wasatchcameraclub.smugmug.com/PSA-Competitions/2023-24/Nature/Round-1/i-HjMqnWr/A
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Exhibits – Recap

November 3 through December 4 – Ogden Union Station 
Planes, Trains, Automobiles, and More

Our latest exhibit was held at the Ogden Train Station in Ogden, Utah. The appropriate theme: 
Transportation was well received. Although we were not represented in the main gallery at street 
level, but in a hallway upstairs, a good number of visitors strolled through the exhibit. The train 
station marketing department held an event that attracted over 2,000 people. The exhibit was of 
interest to a huge crowd and so much appreciated that many guests expressed interest in joining 
the club. A goal for the future is to secure a spot on the main floor where member images will be 
more visible and accessible. Below are a few of the exhibited images. 

 CLICK HERE to view all images.

– Mary Whitesides, Board Director & Social Events Chair

Morant Curve by Thomas Creery
The Deuce by Allen Kendall

Wine The Way by Susan Jones Red Hot Rod by Matt DAlessandro

https://wasatchcameraclub.smugmug.com/Exhibits/Past-Exhibits/Trains-Planes-Autos/
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Exhibits – Upcoming

Utah Cultural Celebration Center – April 25 - June 26 

Red Butte Garden – April 26 - May 30 

Jewish Community Center – September 

The WCC Exhibit Committee has secured the following exhibit space for 2024. More information 
about the submission, curation, delivery, and opening reception schedules will be communicated via 
email and the WCC website in the coming months. CLICK HERE to view images from past exhibits.

UCCC hosts year-round art exhibitions that are managed by     
West Valley Arts. WCC has curated a Utah Travels exhibit through 
WVA for many years. CLICK HERE to view images from the May 
2022 exhibit.

The WCC exhibits have been a popular attraction for 
visitors to the Garden. This year’s theme is Things with 
Wings (in nature.) CLICK HERE to view images from the 
Interpretations of Nature exhibit held at RBG in 2022.

The JCC has been another successful venue for 
WCC photography exhibits in the past. The theme 
and timeline for the exhibit are under development 
and will be communicated to members in late May/
early June. 

Email John Ballard if you are interested in volunteering to help the Exhibit Committee execute one 
or all of these exhibits. 

https://www.wvcarts.org/
https://wasatchcameraclub.smugmug.com/Exhibits/Past-Exhibits/Utah-Travels-2022/
https://wasatchcameraclub.smugmug.com/Exhibits
https://wasatchcameraclub.smugmug.com/Exhibits/Past-Exhibits/Interpretations-of-Nature/
mailto:mentoring@wasatchcameraclub.com?subject=WCC%20Exhibit%20Volunteer%20Opportunties
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One Picture Story 

Creative Corner

CLICK HERE for more One Picture Story submissions. 

About One Picture Story  
Combine short text with a single image that, together, convey a story greater than the sum of its parts. The text 
should not be about the image (as it is for In Focus articles), nor should the image directly illustrate the text. 
Instead, the image should amplify the thought or feeling the text describes. CLICK HERE to submit a JPEG 
image and text. Please use our standard image file naming format (lastname_firstname_image-title.jpg.) 

The day is not done until we play 
Run fierce, no concern or dismay 
  
The now is ours, with chalk and blank slate 
Write boldly, quickly, no time to wait 
  
The light fades until tomorrow true 
Then we paint our canvas yet anew 

The Day is Not Done

– Image and Words by Jeff Clay

mailto:info@wasatchcameraclub.com?subject=One%20Picture%20Story%20Submission
https://wasatchcameraclub.com/news-and-events/one-picture-stories
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In Focus CLICK HERE for more In Focus submissions. 

Creative Corner (cont.)

It’s Just a Sparrow.   

by Krishna Prasad Kotti
Bird photography is one of the most demanding, challenging, and 
rewarding genres of photography (at least to me.) Birds are everywhere in 
nature, so we have plenty of subjects in this genre. You don’t need to travel 
to remote and exotic locations to photograph birds (unless you are after a 
specific species of birds.) One of the things I started to do once I moved to 

Utah 5 years ago was to learn about the birds that are part of our state and 
to photograph them. During this journey (which is still a work in progress,) I decided to narrow down 
the species. I decided to focus on a specific family of species. This year, I am focusing mainly on 
sparrows of Utah. This is the story of how I photographed a Sagebrush Sparrow in Utah. 
  
While I was trying to photograph 
sparrows, I learned about the 
Sagebrush Sparrow. One mistake I 
made during my early days in 
photography was not to study and 
learn about my subjects. I randomly 
went to places and tried to 
photograph birds in that place. This 
caused a lot of issues with long 
travels (driving for 10 hours in the 
night to reach a location, trying to 
photograph a bird early in the 
morning, and driving 10 hours back 
home.) This was counterproductive, 
and I was not getting the 
experiences I sought (spending time 
with birds.) 
  
To be a good bird photographer, you must be a good birder. Once I started learning about birds, I 
realized that the Sagebrush Sparrow nests in Utah. In fact, it is one of the most commonly found 
birds if you know its habitat (Sagebrush.) I found that they are in the western part of Utah. I studied 
the bird’s behavior and reviewed ebird checklists to understand when and where they are reported. I 
tried to photograph them and often failed to make an Image.

Continued on next page…

Photo Credit: Krishna Prasad Kotti

https://wasatchcameraclub.com/news-and-events/in-focus
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About In Focus 
Created for you, the members, to share one image and tell a story about it. What does the image mean to 
you – why did you take the image – was it the location, the person or people in the image, or did something 
else attract you to the composition? It’s up to you! Submit your own story to info@wasatchcameraclub.com. 

In life, luck and skill are only about 10-20%; the rest of the part has to be filled with patience, hard 
work, and perseverance. With these skills, you can achieve anything you want to, whether it is 
photography or other facets of life. As a result of my perseverance, I finally found a few spots close 
to my home and photographed the Sagebrush Sparrow from my car using the car as a photo blind. 
  
Ultimately, it is not just a sparrow for me; it is an image I will cherish for the rest of my life. It is a 
lesson and an experience that I will remember forever. 
  

It’s Just a Sparrow. by Krishna Prasad Kotti (cont.)

Photo Credits: Krishna Prasad 

mailto:info@wasatchcameraclub.com?subject=In%20Focus%20Submission
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Project Slideshow CLICK HERE for more Slideshows. 

About Project Slideshows  
Think of it as creating a mini-documentary. Make a body of work comprised of a number of related images 
and create a MP4 slideshow – with or without music or narration. It is up to you. Members can submit their 
slideshow to info@wasatchcameraclub.com.  

Creative Corner (cont.)

Africa Travelogue by Greg Smith

In March of this year Board Director, Greg Smith, went on a two week Africa tour that included 9 
days of safari in the Kalahari desert and Okavango Delta regions of Botswana. This is an 8-minute 
version of a 23 minute travelogue slideshow of that trip. The video was compiled and rendered 
using Adobe Photoshop. 

CLICK HERE to view the slideshow. 

Photo Credit: Greg Smith

https://wasatchcameraclub.com/news-and-events/project-slideshows/item/203-africa-slideshow-by-greg-smith
mailto:info@wasatchcameraclub.com?subject=Project%20Slide%20Show%20Submission
https://wasatchcameraclub.com/news-and-events/project-slideshows
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CLICK HERE to view all upcoming Presentations CLICK HERE to view all upcoming Workshops

October 11 – Take to the Skies!

– Lisa Thompson, Board Director & Workshops/Presentations Chair

In October, WCC hosted a presentation by Brète Thomas on 
drone (aerial) photography. Brète has over 1,000 hours of flying 
time and frequently photographs the landscapes of southern 
Utah. It was interesting to see how the different perspective of a 
drone can provide a view that the average person cannot see. 
Brète showed us the equipment he uses and how he gets “the 
shot.” It was really interesting and inspiring. Drone photography 
can add a whole new dimension to your photography.

Photo Credit: Brète Thomas

Photo Credit: Brète Thomas

November 30 – The Concept is the Coin of the Realm

In November, Paul Adams presented “The Concept is the Coin of 
the Realm.” Paul explained how it is important that photographers 
have a concept (idea) and how that can contribute to a body of 
work. He had an excellent presentation as he showed some of his 
work and the process behind it. Paul practices some very old 
photo capture techniques that pre-date film. He shared ideas that 
I found to be thought provoking and inspiring.

Photo Credit: Lisa Thompson

Presentations & Workshops – Recap

https://wasatchcameraclub.com/activities/presentations
https://wasatchcameraclub.com/activities/workshops-and-education
https://www.pauladamsphotography.com/
https://www.facebook.com/brete.thomas
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CLICK HERE to view all upcoming Presentations

Presentations & Workshops – Upcoming

CLICK HERE to view all upcoming Workshops

January 17 / 6:30pm - 8:30pm / (SLC Library) – Action Photography

– Lisa Thompson, Board Director & Workshops/Presentations Chair

Coming in February…Advanced Birds In Flight Photography

Sixteen years ago, Dave Argyle went to the local 
high school to get some photos of his daughter who 
had just made the track team. A few years later his 
daughter graduated and moved on, but Dave never 
did. He had fallen in love with sports photography. In 
the years since, as Dave continuously worked to 
improve, he discovered that his preferred approach 
to sports photography also worked for almost any 
type of photography in which the subject is moving 
and can’t stop to say “cheese.”  

This presentation will offer a quick overview of Dave’s approach, followed by a deeper look at two 
critical pieces of that approach, without which none of the rest matters. 

CLICK HERE to read Dave’s bio and to register for this in-person presentation. 

Photo Credit: Dave Argyle

A seasoned bird photographer and birder will 
be giving a unique class on how to capture 
birds in flight – even the fast ones! This is a step 
up in techniques including settings, choosing 
locations, and stabilization. More details, as we 
have them, will be posted on the website and 
sent by email.

Photo Credit: Lisa Thompson

https://wasatchcameraclub.com/activities/presentations
https://wasatchcameraclub.com/activities/workshops-and-education
https://wasatchcameraclub.com/news-and-events/events/action-photography
https://wasatchcameraclub.com/
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Questions: fieldtrips@wasatchcameraclub.comCLICK HERE to view all upcoming and past Field Trips 

Field Trips – Recap

October 7 – HawkWatch at Commissary Ridge

– John Ballard, Board Director & Member/Mentoring Chair

In early October, eight members drove to Wyoming to learn 
about the HawkWatch International raptor count program. High 
on Commissary Ridge, in a remote location north of Kemmerer, 
three researchers showed us how they collect data about the fall 
raptor migration and taught us much about the magnificent 
birds they were watching. 

Commissary Ridge is one of five western U.S. counting sites that 
HawkWatch operates, with the purpose of tracking long-term 
population trends of raptors – hawks, eagles, vultures, owls. The 
information gathered enables them to better understand the life 

histories, ecology, status, and conservation needs of raptor populations in North America. 

There are no permanent structures at the basecamp, just cars and tents. From the 
camp, we hiked a mile up to Commissary Ridge (8,850 ft elevation,) where the 
researchers count birds eight hours every day sitting in primitive rock walls that give 
them shelter. 

At first, without any breezes, few birds were 
spotted. After an hour or two, the wind picked up 
and immediately sightings increased. Hawks and 
eagles, along with Ravens, Pine Siskins and 
others were everywhere. Then we heard that two 
other researchers had trapped and banded a 
hawk. We were able to watch and photograph it 
from a couple feet away – and then the handler 
released it back into the wild. 

On the drive back, we stopped in Kemmerer, a town of 2,600 that appears to 
have missed the mining and oil boom that grew the Wyoming economy for the 
last four decades. The picturesque town square has a large bronze statue of 
James Cash (JC) Penney and is surrounded by photogenic old buildings, many 
sadly empty.  

It was an eleven hour day with many hours of driving. But the rewards of seeing so many majestic raptors and 
learning about HawkWatch’s brilliant research definitely made the long day worthwhile. 

Photo Credit: Dawn Griffith

Photo Credit: Dawn Griffith

Photo Credit: John Ballard

https://wasatchcameraclub.com/activities/field-trips
mailto:fieldtrips@wasatchcameraclub.com?subject=Field%20Trip%20Question
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Questions: fieldtrips@wasatchcameraclub.comCLICK HERE to view all upcoming and past Field Trips 

October 8 – Fall Foliage at Sundance Mountain Resort

– Dawn Griffith, Board Director & Day Field Trips Chair

Field Trips – Recap (cont.)

Although it was a very cold morning, 18 members attended the fall foliage field trip at Sundance 
Mountain Resort. What started out as a quiet morning quickly turned busy as more people showed 
up to enjoy the beautiful fall foliage. Between the wonderful lighting and clear day, those in 
attendance were able to capture stunning images. 

Photo Credit: Dawn Griffith

Photo Credit: Greg Smith

Photo Credit: Greg Smith

https://wasatchcameraclub.com/activities/field-trips
mailto:fieldtrips@wasatchcameraclub.com?subject=Field%20Trip%20Question
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Questions: fieldtrips@wasatchcameraclub.com

Field Trips – Upcoming

CLICK HERE to view all upcoming and past Field Trips 

Memory Grove Snow Shoot 
January 6 / 8:30am - 11:30am

– Dawn Griffith, Board Director & Day Field Trips Chair

January can be a hard month as we come out of the holidays 
and jump into a new year. Memory Grove Park can be quite 
gorgeous in the middle of winter and maybe we could all use 
some camera time? Bring your hot chocolate and layers to 
stay warm for a morning shoot at Memory Grove Park. 
Weather shouldn’t be an issue unless it rains – let’s hope it 
doesn’t!  

CLICK HERE for the history of Memory Grove and to register 
to attend.

Photo Credit: Jennifer Pratt

Utah Lake Ice Formations 
January 20 / 3:00pm - 6:00pm

Last year we missed the Utah Lake ice due to unusual 
warmth and lack of ice. Hopefully we’ll get some ice this 
year as we jump into 2024 and shoot for this again (pun 
intended.) Below are suggested items to bring: 

• Warm clothing/dress in layers 

• Tripod or monopod 

• Micro spikes (if you plan to walk on the ice) 

• Hot liquids to warm you up 

Please note that there will be an entry fee to get into the state park.  

CLICK HERE to register to attend. The meetup location will be sent along with ice safety instructions in the 
registration confirmation email. 

Photo Credit: Scott Stringham

https://wasatchcameraclub.com/news-and-events/events/memory-grove-snow-shoot
mailto:fieldtrips@wasatchcameraclub.com?subject=Field%20Trip%20Question
https://wasatchcameraclub.com/activities/field-trips
https://stateparks.utah.gov/parks/utah-lake/park-fees/
https://wasatchcameraclub.com/news-and-events/events/utah-lake-ice-formations-3
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Questions: overnightfieldtrips@wasatchcameraclub.comCLICK HERE to view all upcoming and past Overnight Field Trips 

– Greg Smith, Board Director & PSA Chair

Field Trips – Overnight – Recap

Beautiful Fall Foliage in Colorado’s San Juan Mountains 
September 28 - October 2

For four delightful nights, a group of club members explored the San Juan 
Mountains of Southwest Colorado in search of the brilliant fall colors and 
renowned sights the area offers. We gathered in a park in Ridgway for a meet-
and-greet session. Paul and Marie Hodges, longtime residents and 
photographers in the area, then led us to a meadow around the East Fork of 
Dallas Creek for an evening shoot. We captured the picturesque meadow,  
a wooden rail fence, and the surrounding mountains, all beneath a rising  
gibbous moon.  

The following morning, we set out early, traversing a dirt road to reach a 
breathtaking overlook. The vista opened to a valley adorned with a dappling  
of yellow-hued trees against a backdrop of snow-capped peaks, prominently 
featuring Mt. Sneffels. Despite a cloudless sunrise hindering our photographic 
opportunities, our excitement peaked when an alleged curious cougar was 
spotted nearby, observing our group.  

The remainder of the day was devoted to exploring the historic mine structures 
of the Red Mountain area, including the iconic Yankee Girl mine. As night fell,  

we engaged in a captivating night shoot at an old mine building, experimenting with various colored lights to 
illuminate its interior.  

The subsequent day saw us retracing our route over Red Mountain 
Pass and the Million Dollar Highway to Silverton. There, we spent 
time photographing the vibrant buildings, capturing shots of the 
narrow gauge trains arriving from Durango, and striking up 
friendships with the local camera store owner. 

Post-lunch, those of us with sturdy vehicles and high clearance 
braved the rocky, arduous 13-mile drive to the ghost town of 
Animas Forks. Perched at an elevation of 11,200 feet, this 
abandoned mining town, deserted since 1920, remained 
remarkably intact and offered intriguing photography 
opportunities, even as scattered snow flurries descended upon us. 

The subsequent morning found us back at Mt. Sneffels, this time blessed with better clouds and a fleeting moment of 
golden light. The Hodges departed early, allowing us to pursue our individual interests for the remainder of the day – 
some revisited favorite locations, while others sought out new, unexplored areas. A subgroup embarked on a day trip 
to Crested Butte and Kebler Pass, home to one of the largest aspen groves in the U.S., offering a stunning display of 
fall colors. Needless to say, we were not disappointed.

Photo Credit: Greg Smith

Photo Credit: Jason Cameron

mailto:overnightfieldtrips@wasatchcameraclub.com?subject=Overnight%20Field%20Trip%20Question
https://wasatchcameraclub.com/activities/over-night-field-trips
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Shutter Up Socials – Recap

Questions: socialevents@wasatchcameraclub.comCLICK HERE to view images from past Shutter Up Socials

– Mary Whitesides, Board Director & Social Events Chair

December 7 – Street Photography
It seems Street Photography is a favorite subject for many of our members. We had a fine showing 
of photographers and their work for our latest Social. Street photography is so spontaneous, tells a 
story and captures a moment in time that speaks volumes about culture and peoples. One 
photographer shared photos he captured on the streets of Salt Lake City and mentioned he is 
always looking for the story. Others shared photos from the streets of New York City. A contrast in 
how people interpret themselves from East to West. The subject was so popular it is sure to be a 
subject of a Shutter Up Social again.

Photo Credit: Liz Roach, NYC

Photo Credit: Mary Whitesides, NYC

https://wasatchcameraclub.smugmug.com/Shutter-Up-Socials
mailto:socialevents@wasatchcameraclub.com?subject=Shutter-up%20Social%20Question
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Shutter Up Socials – Upcoming
Shutter Up Socials are held as Zoom meetings and have provided an opportunity for Wasatch 
Camera Club members to share up to 6 photos with other members without leaving their homes. 
Each Social has an assigned theme and each participant shares how and why they took the photo. 
CLICK HERE for more information on upcoming Socials.  
 

Questions: socialevents@wasatchcameraclub.com

– Mary Whitesides, Board Director & Social Events Chair

CLICK HERE to view images from past Shutter Up Socials

Mountains, Rocks, and Rivers – January 11 / 6:30pm - 8:30pm

Our first Shutter Up Social theme of 
2024 will be Mountains, Rocks, and 
Rivers. Share, via Zoom, your photos of 
these magnificent wonders of nature. 
We have a choice selection of photo 
sites right here in our own state of Utah 
but, don’t hesitate to share photos from 
around the world – wherever you have 
been inspired to document these 
marvels. Share up to 10 photos and be 
prepared to share the story behind the 
shots. See you in January! 

CLICK HERE to register.

Photo Credit: Mary Whitesides, Kerala India

https://wasatchcameraclub.com/activities/shutter-up-socials
mailto:socialevents@wasatchcameraclub.com?subject=Shutter-up%20Social%20Question
https://wasatchcameraclub.com/news-and-events/events/mountains-rocks-and-rivers-shutter-up-social
https://wasatchcameraclub.smugmug.com/Shutter-Up-Socials
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Did You Know?

Resizing Digital Images by Greg Smith 
Level: Beginner to Intermediate
Many photo competitions, including our club and PSA competitions, place a 
limit on the pixel dimensions, and sometimes the file size, of your entries. Why 
is that? Three reasons come to my mind. Foremost, smaller images mean 
smaller file sizes, which are much more efficient to store, open, and transfer. 
This is especially important for the web, or if dealing with hundreds, even 
thousands of contest submissions. Second, while newer computer screens 
have ample resolution, older monitors, projectors, and televisions might max 
out at the High Definition (HD) standard of 1920 x 1080 pixels. Extra large 

images are down-sampled (pixels tossed) or even squashed to fit the display area of the device, potentially 
degrading the image quality further. Better to keep your photo within the limits so that its pixels are rendered 
1:1. Lastly, smaller size tends to equalize images taken with different camera sensor sizes. If you downsize 12 
MP and a 50 MP images of the same subject to 4 x 4 inches at 72 ppi, you will probably have a difficult time 
telling them apart. 
  
I will use the current PSA rule of confining your image within 1920 x 1080 pixels in these examples. First, 
a few concepts and definitions: 
  
ppi vs dpi: ppi (pixels per inch) defines the resolution (amount of data) of your digital image. Dpi is sometimes 
used interchangeably with ppi but refers to the ink dot resolution of a specific printer. It takes around 3 dots to 
print one pixel. 
  
Resizing vs Resampling: Resizing without resampling changes the image dimensions without altering the 
amount of data (number of pixels) in the file. The change is made by altering either the image dimension 
(inches) or the pixel density (resolution.) For example, resizing a 4” x 4” at 100 ppi to 2” x 2” will double the 
resolution to 200 ppi, maintaining the 160,000 pixels of data. Resampling, however, changes the amount of 
data in the image by discarding or inserting new pixels to reduce or enlarge the photo file size, respectively. 
This software interpolation typically degrades the image integrity. Although the loss of quality is generally not 
noticeable when reducing the size, resampling is best avoided (or done as several smaller, incremental steps) to 
enlarge the photograph. 

On to the techniques. 
  
Cellphones: As far as I can tell, you cannot specify pixel dimensions without using a separate app designed for 
that purpose. You must upload your image to a computer and work from there. 

  

  Continued on next page…
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Windows or Mac OS: On Windows machines, double clicking on 
your image opens it in the Photos app (unless you have specified 
another program as the default.) Click on the ellipsis (3 dots) icon 
on the task bar at the top to open a dropdown menu and select 
Resize Image (refer to image on the right.)

If you are using a Mac, selecting the image from Finder or Photos 
opens it in the Preview app. In the menu bar select Tools > Adjust 
Size. Alternatively, click on the Markup Tool (circled icon, upper 
right, in image below) and select the Adjust Size icon (rectangles.)  

Resize windows differ between Macs and PCs. For both you want to set the units to “pixels.” Enter 1080 in the 
Height field. The aspect ratio should be locked (be sure to check the Scale Proportionally box on Mac.) 
Double check that the Width value does not exceed 1920 pixels. If it does, set the width to 1920 instead and 
confirm Height is no more than 1080 pixels. Ignore the resolution fields; we are dealing with absolute pixels, 
not image dimensions for printing, so resolution is immaterial. 

In PCs, set the File Type to JPG. Keep the quality slider to the right unless your 
entry exceeds a file size limit (5mb for WCC competitions and other gallery 
posts.) If your file is too big, nudge the Quality slider to the left until the new file 
size falls within the required limit. Click Save. 

With a Mac the Resample box should be checked, and the Fit Into Field  
set to Custom. Click OK. Go to File > Export to save the resized image, selecting 
JPEG for the Format. If your resampled image still exceeds the file size limit, 
move the Quality slider leftward until File Size meets the requirement. Click Save. 

 

Resizing Digital Images by Greg Smith 

Continued on next page…

Mac: Tools > Adjust Size.

Mac Alternative: Markup Tool

Mac: Quality slider to control 
exported file size

Windows PCs Photo App

Windows PCs: Photos app

Mac: Adjust Size Screen
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Lightroom Classic: Resizing options appear when you export your 
image (File > Export in the menu or the Export button in the 
Library Module.) In File Settings choose JPEG for Image Format, 
and set the Color Space to sRGB. In addition to the Quality slider 
you can, if necessary, specify the maximum file size. When 
checked, the least amount of JPEG compression reaching the 
specified limit is performed, and the Quality slider is grayed out. 
Under Image Sizing, check the Resize to Fit and Don’t Enlarge 
boxes. Select Width and Height from the dropdown menu and 
enter 1920 for “W,” 1080 for “H,” and the units to pixels. Ignore 
the Resolution setting, as explained above. This will automatically resize your image to fit into the dimension limits 
specified for PSA and WCC competitions, HD projectors and TVs. No more setting the long edge to 1920 pixels 
only to have the vertical dimension exceed 1080 (a common mistake!) Output sharpening should always be 
checked. Set the Sharpen For field to Screen and select Standard or High for the Amount. In general, the smaller 
the image, the more output sharpening is needed. Lightroom will fine tune the amount automatically.  
  
Photoshop: The resizing window (Image > Image Size from the upper menu) looks like the screen shot below. Make 
sure the Aspect Ratio is locked (click the chain link to toggle it on and off.) Set the Units to Pixels, and change the 
Height to 1080, double checking that the width does not 
exceed 1920 pixels. Ignore Resolution. Make certain the 
Resample box is checked and choose Automatic from  
the drop menu. The preview menu allows you to try out 
the different resampling algorithms to find what is best 
for that particular image. I find that Automatic often 
works best. The resized dimensions and file size are 
shown at the top of the Resize window. Click OK when 
done. You might consider saving this as a preset, which 
you do by selecting Save Preset… from the Fit To 
dropdown menu. 
  

Be sure to check your resized image at 100% magnification for softness or loss of details. Final output sharpening is 
often necessary for images reduced this degree. This is performed automatically in Lightroom.  

Your Club is now looking forward to seeing your properly resized images in future competitions! 

 

Resizing Digital Images by Greg Smith (cont.)

Lightroom Classic:  Resize screen

Photoshop: Image size screen
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Have an article or online class you’d like to share with club members? Send them to info@wasatchcameraclub.com.

News You Can Use

Brigham City Museum of Art & History Photography Competition

This local photography competition 
may appeal to our members…the 
theme is Intersections and is 
described as “Intersections can be 
found in a physical place, an 
emotional response, a relationship, 
a professional choice, an artistic 
exploration, or almost any other 
part of life that we dare to confront.  

Submissions are due by January 27. The exhibit is open February 3 - April 20. More information on 
the Brigham City Museum of Art & History Photography Competition can be found HERE.

CLICK HERE for more News You Can Use

https://wasatchcameraclub.com/news-and-events/photo-news
https://brighamcitymuseum.org/2024-photography-competition-intersections
mailto:info@wasatchcameraclub.com?subject=Photo%20News%20Suggestion%20for%20Website
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Under Director John Ballard, the Mentoring Program continues to offer aid and instruction 
for new and intermediate photographers, provided by club member volunteers. If you are 
interested in finding a mentor, or want to volunteer your time helping someone improve 
their image-making and photo-editing skills, send your name and questions to John.

Resources
Board Blogs

Mentoring

Shadow-light by Jeff Clay
Shadows are the yin to light's yang. Though, 
strictly speaking they are not always the 
opposite or absence of light, as some details 
often can be seen lurking deep in the nooks 
and crannies of dark regions. They are merely 
the blockage – partial or otherwise – of light.  
I call their presence shadow-light. 
  
Shadows can be as strong a force in 
photography as light itself. The same is true in 
painting. Think of a Rembrandt or 
a Caravaggio and you cannot help but 
visualize inky shadows as well as light-and-
dark-sculpted faces and torsos. In music, 
sometimes the quiet pauses between notes 
heighten and enhance the music to come. 

These are all forms of negative space or ma in the Japanese art world. Ma is an artistic 
interpretation of empty space that often holds as much importance as the rest of the 
image/artwork. Ma is represented by the deep shadows in the four images shown here. 
They are certainly as important as the illuminated landscapes and are needed to craft the 
expressiveness of the photographs. 
  
In the world of dunescapes, shadows are integral to creating a well-made, compelling, and 
yes, beautiful composition. Without them scenes are flat and as lifeless as the desert often 
appears. With those deep pools or dark rivulets, the dunes come alive and speak of 
mystery and sensuousness. They create soft wells to sink your eyes into. Places to linger 
and wonder about. They add grace and form to shapes and lines otherwise commonplace. 
They create a balance and contrast that is both natural and otherworldly. 

Shade for the mind; an oasis of rest. Shadow-light. 

CLICK HERE to view more of Jeff’s Shadow-light images and technical notes. 

https://wasatchcameraclub.com/news-and-events/the-board-blogs/item/210-shadow-light
mailto:mentoring@wasatchcameraclub.com?subject=Mentoring
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Wasatch Camera Club is a proud 
member of the Photographic 
Society of America. For more 

information on individual 
memberships to PSA, visit their    

website at psa-photo.org. 

Club Information 

The Wasatch Camera Club is an all-volunteer organization, governed and run by a Board of Directors. 
Founded in 1994, the Club operates today as a 501(c)(3) nonprofit organization. The Club provides a  
rich and enjoyable environment in which to improve your photography skills with activities that support 
our educational goal. These include workshops, field trips, lectures, exhibits, competitions and  
one-on-one mentoring. Annual membership fee is $50. For additional information, go to the  
Wasatch Camera Club website or email info@wasatchcameraclub.com. 

Executive Committee

Jeff Clay Board Chair & Exhibits Chair exhibits@wasatchcameraclub.com

John Nellist Treasurer treasurer@wasatchcameraclub.com

Claudia O’Grady Secretary & Overnight Field Trips Chair overnightfieldtrips@wasatchcameraclub.com

Directors & Committee Members

Jason Hutchison Board Director, Competitions Chair & Galleries 
Manager

competitions@wasatchcameraclub.com

Dawn Griffith Board Director & Day Field Trips Chair fieldtrips@wasatchcameraclub.com

Lisa Thompson Board Director & Workshops/ 
Presentation Chair

workshops@wasatchcameraclub.com

Mary Whitesides Board Director & Social Events Chair socialevents@wasatchcameraclub.com

John Ballard Board Director & Membership/ 
Mentoring Chair

mentoring@wasatchcameraclub.com

Greg Smith Board Director & PSA Chair psa@wasatchcameraclub.com

Cindy Costa Board Director & Newsletter Editor newsletters@wasatchcameraclub.com

Randy Gerdes Social Media Coordinator socialmedia@wasatchcameraclub.com

About WCC

© Wasatch Camera Club, 2023. All images appearing in this newsletter are copyrighted by the maker. 

Unauthorized use and/or duplication of this material or images/photographs without express and written 

permission from maker and/or owner is strictly prohibited.
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